DATA CREDITS

Quick-Start Tutorial Data: Wilson, North Carolina.
The African Landscape Map: Major Habitat Types—Conservation Science Program, WWF-US; Rainfall—ArcAtlas™, ESRI, Redlands, California; Population data from EROS Data Center USGS/UNEP.
Amazonia Map: Conservation International.
Forest Buffer Zone—100 Meters Map: U.S. Forest Service (Tongass Region).
Horn of Africa Map: Basemap data from ArcWorld™ (1:3M), ESRI, Redlands, California; DEM and Hillshade from EROS Data Center USGS/UNEP.
Mexico: ESRI Data & Maps CDs, ESRI, Redlands, California.
Rhode Island, the Smallest State in the United States: Elevation data from the USGS, EROS Data Center; other data from ESRI Data & Maps CDs, ESRI, Redlands, California.
Countries of the European Union: Member States and Candidate Country information from EUROPA (The European Union On-Line); ESRI Data & Maps CDs, ESRI, Redlands, California.
Mexico Population Density Map: ESRI Data & Maps CDs, ESRI, Redlands, California.
Health Care in the United States Map: Population data from U.S. Department of Census; Health Service Areas from the trustees of Dartmouth College; Service Providers data from Healthcare Financing Administration.
Clark County Land Use Map: Clark County Office, Washington State.
Southeast Asia Population Distribution Map: ArcWorld (1:3M), ESRI, Redlands, California.
Australia Map: Major Habitat Types data from Conservation Science Program, WWF-US; Basemap from ArcWorld (1:3M), ESRI, Redlands, California.
New Hampshire Telecom Map: Geographic Data Technology, Inc.
Redlands Image: Courtesy of Emerge, a division of TASC.

CONTRIBUTING WRITERS

U.S. GOVERNMENT RESTRICTED/LIMITED RIGHTS
Any software, documentation, and/or data delivered hereunder is subject to the terms of the License Agreement. In no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a minimum, use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in FAR §52.227-14 Alternates I, II, and III (JUN 1987); FAR §52.227-19 (JUN 1987) and/or FAR §12.211/12.212 (Commercial Technical Data/Computer Software); and DFARS §252.227-7015 (NOV 1995) (Technical Data) and/or DFARS §227.7202 (Computer Software), as applicable. Contractor/Manufacturer is ESRI, 380 New York Street, Redlands, CA 92373-8100, USA.

ESRI, the ESRI globe logo, ArcInfo, ArcEditor, ArcView, ArcMap, ArcCatalog, ArcGIS, ArcReader, ArcSDE, SDE, ArcObjects, ArcIMS, ArcPress, ArcToolbox, GIS by ESRI, the ArcGIS logo, Geography Network, the Geography Network logo, www.geographynetwork.com, and www.esri.com are trademarks, registered trademarks, or service marks of ESRI in the United States, the European Community, or certain other jurisdictions.

The Microsoft Internet Explorer logo is a trademark of Microsoft Corporation.

Other companies and products mentioned herein are trademarks or registered trademarks of their respective trademark owners.
ArcMap Tutorial

IN THIS TUTORIAL

• Exercise 1: Exploring your data
• Exercise 2: Working with geographic features
• Exercise 3: Working with tables
• Exercise 4: Editing features
• Exercise 5: Working with map elements

The best way to learn ArcMap is to try it yourself. This tutorial guides you through some basic ArcMap skills as you create and print a set of maps for a county that is planning to expand its airport.

Residents of the county have identified several issues they are concerned about. These include noise affecting schools and houses near the airport and increased traffic along major roads. In this tutorial, you’ll first create and print a map showing schools near the airport. Then you’ll place this map—along with two other maps that show land use surrounding the airport and population density for the county—on a wall-sized poster for display.

In the tutorial, you’ll learn how to:
• Display map features.
• Add data to your map.
• Edit geographic data.
• Work with data tables.
• Query and select geographic features.
• Create a summary graph.
• Lay out and print a map.

There are five exercises. Each exercise takes between 30 and 45 minutes to complete. You can work through the entire tutorial or complete each lesson one at a time.
Exercise 1: Exploring your data

In this exercise, you’ll create a map showing locations of schools near the airport, along with a noise contour, to see which schools may be affected by noise from the airport. The noise contour is based on the 65 Community Noise Equivalency Level (CNEL), which indicates areas experiencing more than 65 decibels of noise, averaged over a 24-hour period. In many cases, buildings within the 65 CNEL will need soundproofing or other mitigation measures.

The exercises use the tutorial data distributed with ArcGIS Desktop. The default install location of the data is C:\ArcGIS\ArcTutor\Map. The exercises require that you have write access to this data. If you don’t, you’ll need to copy the data to a location that you do have write access to.

Starting ArcMap

ArcMap lets you explore your geographic data and create maps for display.

1. Click the Start button on the Windows® taskbar.
2. Point to Programs.
3. Point to ArcGIS.
4. Click ArcMap.

Opening an existing map document

The first time you start ArcMap, the Startup dialog box appears. The Startup dialog box offers you several options for starting your ArcMap session. For this exercise, you want to open an existing map document.

1. Double-click Browse for maps. If this is not the first time ArcMap has been started and the Startup dialog box does not appear, click File on the Main menu and click Open.
2. In the dialog box, click the Look in drop-down arrow, and navigate to the Map folder on the local drive where you installed the tutorial data (the default installation path is C:\ArcGIS\ArcTutor\Map).

3. Double-click airport.mxd. ArcMap opens the map.

This particular map contains the following layers in a data frame called Schools:

- schools: locations of elementary, middle, high, and private schools
- runways: location of airport runways
- arterials: major roads
- cnel65: the noise contour
- airport_area: the proposed airport expansion zone
- county: the county boundary

The map currently displays the arterials, noise contour, airport area, and county boundary. Their boxes are checked in the table of contents.

ArcMap stores a map as a map document (.mxd) so you can redisplay it, modify it, or share it with other ArcMap users. The map document doesn’t store the actual data, but rather references the data stored on disk along with information about how it should be displayed. The map document also stores other information about the map, such as its size and the map elements it includes (title, scale bar, and so on).

To the left of the ArcMap display window is the table of contents, showing you which geographic layers are available to display. To the right is the map display area.
Moving around the map

The Tools toolbar lets you move around the map and query the features on the map. Place your pointer over each icon (without clicking) to see a description of each tool.

1. Using the Zoom In tool, draw a box around the noise contour to zoom in. Place the pointer on the upper-left part of the contour, press the mouse button, and hold it down while dragging to the lower right. You’ll see the box drawn on the screen. When you release the mouse button, ArcMap zooms in to the area defined by the box.

2. If necessary, use the Pan tool (the hand) on the Tools toolbar to reposition the map so the noise contour is in the center of the display area (hold the mouse button down while dragging in the direction you want to move the features, then release the button).

Displaying a layer

The table of contents lets you turn layers on and off in the display. To display a layer, check the box next to its name. To turn it off, uncheck it. Display the schools and runways by checking their boxes in the table of contents.
Changing the display symbol

ArcMap lets you change the colors and symbols you use to display features. You’ll change the symbols for schools from a dot to a standard symbol used for schools on many maps.

1. Click the dot symbol in the table of contents to display the Symbol Selector window.

2. Scroll down until you find the School 1 symbol and click it.

3. Click OK.

The schools are drawn with the new symbol.

You can also open the symbol dialog box by right-clicking the layer name, choosing Properties from the menu that appears, and clicking the Symbology tab. To simply change the color of a symbol, right-click the symbol in the table of contents to display the color palette.
**Identifying a feature**

There is one school that may be within the noise contour around the airport.

1. Using the Zoom In tool, draw a box around the school to zoom in.

You can see that the school is indeed within the noise contour.

2. Click the Identify tool on the Tools toolbar. The Identify window appears.

3. Move the mouse pointer over the school and click. The name of the school (Northwestern Prep) is listed in the Identify window. Notice that only the features in the topmost layer are identified. You can also identify features in other layers by choosing the specific layers you want to identify by clicking the Layers drop-down arrow in the dialog box.

Close the Identify window.
4. Click the Back button on the Tools toolbar to return to your previous view.

**Adding graphics**

You can add text and other graphics to your display using the Draw toolbar at the bottom of the ArcMap window.

1. Click the New Text button. The pointer changes to a crosshair with an A.

2. Move the mouse pointer near the school you identified and click.

3. In the text box that appears, type “Northwestern Prep” and press Enter.

A blue dotted line surrounds the text, indicating it is currently selected. You can drag the text to a new position by clicking and holding down the mouse button while dragging the text, then releasing the button.

4. When you’re finished positioning the text near the school, click outside the text box to deselect it.
Laying out a map

ArcMap lets you work in data view or layout view. Data view focuses on a single data frame. Use data view when exploring or editing your data. Layout view shows you how the map page looks. Use layout view when composing and printing a map for display. You can also explore and edit your data in layout view.

You can change the size and orientation of the page in layout view. In this case, you’ll create a 16- by 12-inch map with a landscape orientation.

1. Click the Fixed Zoom Out button on the Tools toolbar several times to zoom to a smaller map scale.
2. Click the View menu and click Layout View. The Layout toolbar appears, and the display changes to show the page layout with rulers along the side.

3. Right-click anywhere on the layout background and click Page and Print Setup. You can also access Page and Print Setup from the File menu.

4. Make sure the Use Printer Paper Settings box is not checked; otherwise, the page size will default to be the same as your printer. If your printer does not print larger sizes, you can scale down the map when you print it, as you’ll see later in this exercise.

5. Check Scale Map Elements proportionally to changes in Page Size. That way, the data will be rescaled to fit the page.


7. Set the page width to 16 and the height to 12 inches by clicking in each box and typing over the existing values.
Zooming in on the page

The Layout toolbar controls your view of the scale and position of the whole map, as opposed to the data layers on the map. By default, the map size is set so you can see all of it; however, at this scale, it’s hard to see the school name.

1. Click Zoom to 100% on the Layout toolbar. The page is displayed at the actual printed size so you can see the detail.

2. Click the Pan button on the Layout toolbar and drag the map to the lower left so you can see the name of the school.

8. Click OK. The page and rulers change to reflect the new size and orientation.

9. Resize your data frame manually to make it look like the map below. To do this, click the Select Elements tool on the Tools toolbar, click the data frame, and resize the data frame using the blue selection handles.
3. Click the Zoom Whole Page button on the Layout toolbar to see the entire page again.
2. On the Draw toolbar at the bottom of the window, click the Text Size drop-down arrow and click 36 to change the title to 36 point.

3. Click the title and drag it so it’s centered at the top of the map.

The Draw toolbar lets you add and change the format—font, size, color, and so on—of text and graphic elements, such as boxes, callout lines, or circles, on your map.

4. Click Insert and click Legend.

The Legend Wizard appears.

5. Click Next several times to step through the wizard accepting the default legend parameters. Click Finish when done.

By default, ArcMap scales the legend to the page and includes all the layers that are currently displayed. You can modify the legend by right-clicking it and choosing
Properties from the menu that appears. For now, just use the default legend. Later, you’ll learn how to customize legends and other map elements.

6. Click and drag the legend to the lower-left corner of the map.


8. Click ESRI North 1 and click OK. Click and drag the North arrow so it is to the right of the legend.

9. Insert a scale bar from the Insert menu.

8. Click ESRI North 1 and click OK. Click and drag the North arrow so it is to the right of the legend.
10. Click Scale Line 1 and click Properties.

11. Click the Scale and Units tab.
12. Check the box to display one division before zero and change the division units to miles. Then, click OK on all dialog boxes.

13. Click and drag the scale bar under the legend and North arrow.
14. Click the legend to select it; while holding down the Shift key, click the scale bar to select it as well.

15. Click Drawing on the Draw toolbar, point to Align, and click Align Left from the menu that appears. The scale bar is now aligned with the left side of the legend.
**Printing a map**

At this point, your first map is finished. If you have a printer connected to your computer, you can print the map.

1. Click File and click Print.

2. If the map, which is 16 by 12 inches, is larger than your printer paper, click Scale Map to fit Printer Paper.

3. Click Setup.

4. Click Landscape on the Printer Setup panel.

5. Click OK to close the Page and Print Setup dialog box.
6. Click OK on the Print dialog box to print your map.

**Saving a map**

Save your map in the folder with the tutorial data. First, though, ensure that ArcMap uses the full pathname of the location of the data on your system. The airport map was created using relative pathnames, so ArcMap would find and display the data after the ArcTutor\Map folder is copied to your system.

2. Click Data Source Options on the Properties dialog box.
3. Click Store full path names and click OK.
4. Click OK on the Properties dialog box.

Now save a copy of your map. You’ll use this copy in the subsequent exercises.

1. Click File and click Save As.
2. In the File name box, type “airport_ex”.
3. Click Save.

You can continue with the tutorial or stop and complete it at a later time.
Exercise 2: Working with geographic features

In this exercise, you’ll map the amount of each land use type within the noise contour. You’ll add data to your map, draw features based on an attribute, select specific features, and summarize them in a graph.

If necessary, start ArcMap, navigate to the folder where you saved the map from Exercise 1 (airport_ex), and open the map.

**Changing the page layout**

First, you’ll create the map layout by changing the page size and orientation.

1. Make sure you’re in layout view (click the View menu and click Layout View).

2. Click File and click Page and Print Setup.

3. Click the Standard Sizes drop-down arrow and click ANSI E. That sets the width and height to a standard E-size page.

4. Click Portrait on the Map Page Size panel.

5. Uncheck Scale Map Elements proportionally to changes in Page Size; this way, the existing map of schools will remain the same size, rather than being scaled up to fit the page.
6. Click OK. The page size changes, and the existing map is displayed in the lower-left corner.

7. Click the Select Elements tool on the Tools toolbar.

8. Click and drag a box around the elements to select them.

9. Click and drag the group of elements to the upper portion of the page.
Creating a new data frame

A data frame is a way of grouping a set of layers you want to display together. Now you’ll add a new data frame to show land use.

1. Click Insert and click Data Frame.

The frame appears on the layout and is listed in the table of contents.

Adding a data layer

You’ll map land use based on a code for each land parcel. First, add the parcels layer to the data frame.

1. Make sure the New Data Frame is the only data frame selected on the page.

2. Click the Add Data button on the Standard toolbar.

3. Navigate to the Map folder on the local drive where you installed the tutorial data (the default installation path is C:\ArcGIS\ArcTutor\Map).

4. Double-click the airport geodatabase, airport.gdb.

5. Click the parcels layer and click Add.
The data layer is added to the table of contents and displays in the layout (the parcels may be a different color on your map).

All the data used in this tutorial is stored in a geodatabase. ArcMap also lets you work with ArcInfo® coverages, shapefiles, image files, and many other data formats.

**Setting properties of the data frame**

1. Hold down the Shift key and click the top data frame on the page so both frames are selected.
2. Click Drawing on the Draw toolbar, point to Distribute, and click Make Same Size.

Both data frames are now the same size. Click the parcels data frame on the page so it is the only data frame selected.
3. Right-click New Data Frame in the table of contents and click Properties. You may need to hold your pointer over the arrow at the bottom of the menu to see Properties in the list.

4. Click the General tab, highlight the existing text in the Name text box, and type “Land Use”.

5. Click the Display drop-down arrow and set the display units to Feet. You can’t change the map units because they are based on the data frame’s coordinate system.

6. Click Apply.

7. Click the Size and Position tab.

8. Set the X position to 15 and the Y position to 15 by typing in the text boxes. This sets how far the lower-left corner of the data frame is, in inches, from the lower-left corner of the page. (You can specify X,Y position for another location on the data frame by clicking the appropriate box on the diagram.)
You can specify the position of any object on the page—the data frame itself, text, legends, and so on—either by selecting and dragging them or by setting the X and Y position explicitly.

9. Click OK. The data frame is repositioned.

**Copying a layer**

You’ll want to display the noise contour and airport area with the parcels. You can copy them from the Schools data frame. First, switch back to data view.

1. Click the View menu and click Data View. Now you’re looking at only the area covered by the parcels, rather than the entire map.

2. In the table of contents, right-click the airport_area layer under the Schools data frame and click Copy.

3. Right-click the Land Use data frame and click Paste Layer(s).

4. Copy and paste the cnel65 layer the same way.
**Displaying features by category**

By default, all the parcels are drawn using the same symbol when you add them. You can also draw them based on an attribute—in this case, type of land use.

1. Right-click parcels in the table of contents and click Properties.

2. Click the Symbology tab. All parcels are currently drawn using the same symbol (the same solid fill color).

3. Click Categories in the Show box. Unique values is automatically highlighted.

4. Click the Value Field drop-down arrow and click LAND_USE as the field to use to shade the parcels.

5. Click Add All Values. A unique color is assigned to each land use type.

6. Click OK. The parcels are now drawn based on their land use type.
**Using a style**

ArcMap uses a random set of symbols to draw the land use types (although you can change the color scheme). You can change an individual color by double-clicking it and specifying a new color in the Symbol Selector, or you can specify a style to use predefined colors and symbols (a style is a set of elements, symbols, and properties of symbols stored in ArcMap, often specific to an application or industry). ArcMap provides some standard styles, and you can also create your own. You’ll use a land use style created for this tutorial.

1. Right-click parcels in the table of contents and click Properties.
2. Click the Symbology tab.
3. Under Categories in the Show window, click Match to symbols in a style.
4. Click the Browse button and navigate to the Map folder on the local drive where you installed the tutorial data (the default installation path is C:\ArcGIS\ArcTutor\Map). Click the land_use style and click Open.
5. Click Match Symbols.
6. Click the check box to deselect and turn off the symbol displayed for <all other values>.
7. Click OK. The parcels will now be drawn using colors defined in the style.
Selecting features geographically

To find out how much of each land use is within the noise contour, select only those parcels within the contour.
1. Click Selection and click Select By Location.

   ![Main Menu](image)

   The Select By Location dialog box guides you through creating a geographic query.

2. In the first box, click the drop-down arrow and click select features from.
3. In the second box, check parcels as the layer to select features from.
4. Click the drop-down arrow for the third box and click intersect. This will select those features in parcels that intersect the features of cnel65.
5. In the last box, click the drop-down arrow and click cnel65 as the layer to select by.
6. Click Apply. The selected parcels are outlined in a thick line.

7. Close the Select By Location dialog box. Notice that any parcel even partially inside the contour is included.
Exporting a layer

To find out how many parcels and how much land area of each land use type are within the noise contour, you’ll create a new feature class and run statistics on its data table.

1. Right-click parcels in the table of contents, point to Data, then click Export Data.

2. In the Export Data dialog box, click the Export drop-down arrow and click Selected features (to export only the selected parcels).

3. Save the selected features in the airport geodatabase as a feature class called parcels_sel. Type the path as shown below, substituting the install location of the tutorial data on your system. (The default installation path for the geodatabase is C:\ArcGIS\ArcTutor\Map\airport.gdb.)

4. Click OK. ArcMap exports the parcels to a new feature class in the airport geodatabase.

5. Click Yes when prompted to add the exported data as a new layer on the map. The new layer contains only the selected parcels.

6. Right-click the original parcels layer, point to Selection, then click Clear Selected Features.
7. The new layer is displayed on top of the other layers. To see the noise contour and airport area, click parcels_sel in the table of contents and drag it down until the bar is above parcels. Then release the mouse button.

Creating summary statistics

ArcMap includes tools for statistical analysis. You’ll create a table to summarize the number of parcels of each land use type within the noise contour and the total area of each type.

1. In the table of contents, right-click the parcels_sel layer and click Open Attribute Table.

2. Right-click the LAND_USE field header and click Summarize.
3. Make sure the field to summarize is LAND_USE.
4. Click the plus sign next to Shape_Area to expand it. Check Sum to summarize the area by land use type.
5. Create the output table in the airport geodatabase and name it lu_frequency.
6. Click OK. ArcMap creates a new table with a record for each land use type showing the number of parcels of that type and the total land area (in square feet).

### Opening a table

You may have noticed that when the table is added to the map, the table of contents switches from the Display tab to the Source tab (at the bottom of the table of contents). The Source tab shows the location of all data in the table of contents; this is useful when editing data in ArcMap because it shows you which layers are in the same workspace. (When you edit in ArcMap, you edit an entire workspace; that is, all the layers in the workspace are available for editing.) The Source tab also lists all tables. Tables don’t show up when the Display tab is selected since a table is not a geographic feature that gets displayed on the map.

1. Right-click lu_frequency in the table of contents and click Open. You can see the number of parcels and the total area (in square feet) of each land use type.

2. Close the table window.

7. Click Yes when prompted to add the resulting table to the map. Close the parcels_sel attribute table.
Making a graph

Next you’ll create a column graph showing the number of parcels of each land use type.

1. Click the Tools menu, point to Graphs, and click Create. The Create Graph Wizard appears.

2. Click Vertical Bar for the graph type.

3. Click lu_frequency for the Layer/Table containing the data to graph.

4. Click Cnt_LAND_USE as the Value field to graph.

5. Click LAND_USE for the X label field so the bars will be labeled by land use categories.

6. Uncheck Add to legend, since the graph does not need a legend.

The Color drop-down list allows you to specify how the colors are assigned to the bars. You can choose to match the layer’s symbology (only when working with layers with geographic data), use a palette, or set the bars to be all the same color.

7. Click the Color drop-down arrow and click Palette, then click Excel for the color scheme.

8. Click Next.
9. Make sure that all features/records will be shown on the graph.
10. Type “Land Use in Noise Contour” as the title.

11. Click the Left axis sub-tab. Make sure Visible is checked, then type “Number of parcels” for the title.
12. Click the Bottom axis sub-tab. Make sure Visible is checked, then type “Land use types” for the title.
13. Click Finish.

The graph appears in a new window. You can see that most of the parcels are residential.

Adding the graph to the layout

Now that you’ve created the graph, you can add it to your layout page. The graph on the layout is dynamic and will update if you make any updates to the graph’s properties or the data you’re graphing.

1. Right-click the window and click Add to Layout.
2. Close the graph window.
3. Click the Select Elements tool on the Tools toolbar.

4. Click and drag the graph to the left of the Land Use data frame. Resize it to make it fit better in the space.

5. With the graph still selected, hold down the Shift key and click the land use map so both are selected.

6. Click the Drawing drop-down arrow on the Draw toolbar, point to Align, and click Align Bottom to line up the graph and map.

You can stop here or continue with the next exercise. Save your work by clicking Save on the File menu.
Exercise 3: Working with tables

In this exercise, you’ll map population density for the county. A population density map shows where people are concentrated. First, you’ll add population data for each census tract. Then you’ll calculate population density for each tract and map it.

If necessary, start ArcMap, navigate to the folder where you saved the map from Exercise 2 (airport_ex), and open the map.

Creating a new data frame

As with the land use map, you’ll start by creating a new data frame to display the data.

1. Switch to layout view, if necessary (click View and click Layout View).
2. Click Insert and click Data Frame.
3. Hold down the Shift key and click the middle data frame (Land Use) on the page so both frames are selected.
4. Click Drawing on the Draw toolbar, point to Distribute, and click Make Same Size.

The data frames are now the same size.

5. In the table of contents, right-click New Data Frame 2 and click Properties.
6. Click the General tab and type “Population Density” in the Name text box.
7. Click the Size and Position tab.
8. Set the X position to 9 and the Y position to 2.5.

9. Click OK.

10. Click the Population Density data frame on the page so it is the only one selected.

Adding data from ArcCatalog

You’ll add the layers you need by dragging them from ArcCatalog™.

1. Start ArcCatalog by clicking the ArcCatalog button on the Standard toolbar in ArcMap. Position the ArcCatalog and ArcMap windows so ArcMap is visible behind the ArcCatalog window.
2. In ArcCatalog, navigate to the Map folder on the local drive where you installed the tutorial data (the default installation path is C:\ArcGIS\ArcTutor\Map).

3. Click the plus sign next to the Map folder to list the contents.

4. Click the airport geodatabase icon to display the contents in the right panel.

5. In the right panel, click arterials.

6. Hold down the Ctrl key and click tracts and airport_area to select them as well. The layers are highlighted as you select them.

7. Point to arterials, hold down the mouse button, and drag the pointer over the ArcMap layout view (anywhere is fine).

8. Release the mouse button. All three layers are added to the new data frame.

9. Close ArcCatalog.

10. Click tracts in the ArcMap table of contents so only it is selected. Right-click tracts and click Zoom To Layer. The map redraws to show all the tracts and centers them in the data frame.
11. Right-click the Population Density data frame in the table of contents and click Properties.

12. Click the General tab, click the Display drop-down arrow, and set the display units to Feet. You can’t change the map units because they are based on the data frame’s coordinate system. Click OK.

Adding tabular data

You also need to add the table containing the population data to your data frame.

1. In ArcMap, click the Add Data button.
2. Navigate to the Map folder on the local drive where you installed the tutorial data (the default installation path is C:\ArcGIS\ArcTutor\Map) and double-click the airport geodatabase.
3. Click tract_pop (the icon looks like a table).
4. Click Add. The table is added to the Population Density data frame in the table of contents. ArcMap Activates the Source tab so you can access the table.

Joining tables

The next step is to join the table containing the population data to the census tract data table. You’ll do this using the census tract ID as the common field.

1. Right-click tracts in the table of contents and click Open Attribute Table to see the existing attributes including the census tract ID.

Adding tabular data

You also need to add the table containing the population data to your data frame.

1. In ArcMap, click the Add Data button.
2. Navigate to the Map folder on the local drive where you installed the tutorial data (the default installation path is C:\ArcGIS\ArcTutor\Map) and double-click the airport geodatabase.
3. Click tract_pop (the icon looks like a table).
4. Click Add. The table is added to the Population Density data frame in the table of contents. ArcMap Activates the Source tab so you can access the table.

Joining tables

The next step is to join the table containing the population data to the census tract data table. You’ll do this using the census tract ID as the common field.

1. Right-click tracts in the table of contents and click Open Attribute Table to see the existing attributes including the census tract ID.
Right-click tract_pop in the table of contents and click Open. The table contains the TRACT_ID field and the population of each tract.

Close the tables before proceeding with the join.

2. Right-click tracts in the table of contents again, point to Joins and Relates, and click Join.

3. Click the drop-down arrow in the first text box and click Join attributes from a table.

4. Click the drop-down arrow in the next text box, scroll down, and click TRACT_ID as the field in the layer to base the join on.

5. Click the drop-down arrow in the next text box and click tract_pop as the table to join to the layer.

6. In the next text box, click TRACT_ID as the field in the table to base the join on.

7. Click OK to join the table to the layer. Click Yes if you are prompted to create an index.
8. Right-click tracts and click Open Attribute Table. The population value has been added to each tract.

Adding a field to an attribute table

To map population density, you’ll need to add a new field to the tracts layer. You’ll use this field to store the population density of each tract.

1. Click the Options button at the bottom of the Attributes of tracts window and click Add Field.

If a message appears indicating the table is in use by another user, make sure you closed ArcCatalog.

2. In the Add Field dialog box, type “POP_DEN” as the field name.

3. Click the Type drop-down arrow and click Long Integer.

4. Click OK.

You should see the new field added to the attribute table. The field name you entered will be concatenated with tracts, to appear as tracts.POP_DEN.
Calculating attribute values

You’ll calculate the population density for each tract by dividing the population by the area of each tract; this will give you the number of people per square mile. To do this, you’ll use the editing functions of ArcMap to edit the census tract attributes. You can make calculations without being in an editing session; however, in that case, there is no way to undo the results. (In Exercise 4, you’ll edit the geometry of a feature.)

1. Click the Editor Toolbar button on the Standard toolbar. The Editor toolbar appears.

2. Click Editor and click Start Editing.


The first part of the formula is entered for you tracts.POP_DEN = . The full formula will look like this: tracts.POP_DEN = [tract_pop.POPULATION] / ([tracts.Shape_Area] / 27878400).

Dividing the area by 27,878,400 converts the area of each tract, stored in square feet, to square miles. You can type the formula right into the box or use the buttons on the dialog box. In this exercise, you’ll use both.

4. Double-click tract_pop.POPULATION in the Fields list.

5. Click the division symbol.

6. Type a space and a left parenthesis from the keyboard.

7. Double-click tracts.Shape_Area from the field list.

8. Click the division symbol (same as step 5).

9. Type a space and type “27878400”.

10. Type a space and a right parenthesis from the keyboard.

11. Click OK.
When the dialog box closes, you can see the population density values for each tract in people per square mile in the table.

<table>
<thead>
<tr>
<th>Attributes of tracts</th>
</tr>
</thead>
<tbody>
<tr>
<td>FID</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

12. Click the Editor menu on the Editor toolbar and click Stop Editing.

13. Click Yes when prompted to save your edits.
14. Close the Editor toolbar and close the attribute table.

**Classifying features by quantity**

You can now map the tracts based on their population density values to see where people are concentrated in relation to the airport and to major roads.

1. Right-click tracts in the table of contents and click Properties.

2. Click the Symbology tab. All tracts are currently drawn using the same symbol (the same solid fill color).
3. Click Quantities in the Show box. Graduated colors is automatically highlighted.

4. Click the Value drop-down arrow and click tracts.POP_DEN as the field to use to shade the tracts.

5. Click the Color Ramp drop-down arrow and click the green (light to dark) color ramp.

ArcMap chooses a classification scheme and the number of classes for you. You can modify these by clicking the Classify button in the Layer Properties dialog box. For this tutorial, use the default classification.

6. Click OK.

7. Click the Display tab at the bottom of the table of contents.

8. Arterials should be at the top of the layers list. If not, click arterials in the table of contents and drag it to the top of the layers list in the Population Density data frame. Click airport_area and drag it so it is just below arterials. Now these layers draw on top of the tracts.

9. Right-click the symbol for arterials in the table of contents and click Dark Umber.

10. Click the symbol for airport_area and set it to Blue (the Blue symbol with a black outline) in the Symbol Selector dialog box.

11. Switch to data view, if necessary, to get a closer look at the tracts. Click View and click Data View.

You’ve now completed Exercise 3. You can continue with the next exercise or continue at a later time. Be sure to save your work by clicking Save on the File menu.
Exercise 4: Editing features

You can use ArcMap to edit your data as well as create maps. In this exercise you’ll extend the airport road to create a new loop road joining an existing arterial road.

If necessary, start ArcMap, navigate to the folder where you saved the map from Exercise 3 (airport_ex), and open the map.

Exporting data

You’ll be working with the Schools data frame. First, make a copy of the arterials data. That way, you can start over again with the original data if necessary.

1. Switch to data view by clicking the View menu and clicking Data View if necessary.
2. Right-click the Schools data frame in the table of contents and click Activate.
3. Right-click arterials, point to Data, and click Export Data.
4. Click the Export drop-down arrow and click All features.
5. Click Use the same coordinate system as this layer’s source data.
6. Save the new feature class as arterials_new in the airport geodatabase (the default installation path is C:\ArcGIS\ArcTutor\Map\airport.gdb).
7. Click OK to export the data.
8. Click Yes when prompted to add the layer to the map.

Using Export makes a copy of the data itself. If you’d chosen Copy from the menu, you’d be copying the layer, which is only a pointer to the underlying data and information about how the data is displayed.

**Creating a new feature**

You edit features in ArcMap using the Editor toolbar. All the layers in a workspace are available for editing within the same editing session. You specify the layer (the “target”) to which new features will be added.

1. Click the Zoom In button on the Tools toolbar and zoom in to the area around the existing road and the road you’re adding.

2. Turn off the arterials, cnel65, and airport_area layers by unchecking the boxes next to them in the table of contents so you can more easily see the existing roads.
3. Click the Editor Toolbar button to display the Editor toolbar.

4. Click the Editor menu and click Start Editing.

**Setting snapping**

Snapping lets you specify that new features connect to or align with existing features.

1. Click Editor and click Snapping.

2. Check the boxes for Edge and End for arterials_new. This specifies that the new line you draw in the arterials_new dataset will snap to existing lines (edges) and endpoints of existing lines.

3. Close the Snapping Environment dialog box.

**Digitizing a feature**

1. Click the Target drop-down arrow and click arterials_new as the feature class in which you want to create new features.

2. Click the Sketch tool on the Editor toolbar.
3. The pointer changes to a crosshair with a circle. Move the mouse pointer over the end of the existing road—the circle snaps to the end.

4. Click to start the new road.

5. Move the mouse pointer back over the existing road and right-click to display the context menu.

6. Click Parallel.

7. Move the mouse pointer in the direction you want the new road to go (up and to the right). Right-click and click Length.
8. Type “900” (map units) and press Enter. ArcMap places a vertex at the correct location.

9. Right-click again and click Tangent Curve.

10. Click the drop-down arrow in the upper box and click Arc Length. Click the box to the right and type a length of “400”. In the lower box, click the drop-down arrow and click Delta Angle. Click the box to the right and type “90” (degrees). Click the button next to Right, if necessary, then press Enter.

ArcMap draws the curve.
11. Move the mouse pointer so it snaps to the existing road, but don’t click the mouse. You want the next segment of the new road to be parallel to the existing road.

12. Right-click and click Parallel. The line is constrained to be parallel to the existing road.

13. To finish the road, move the mouse pointer over the road that you want the new road to intersect, and make sure the circle snaps to it. Double-click to end the line.
The new road is highlighted in a thick blue line.

**Adding attributes to new features**

You can also add the name of the new road.

1. Click the Attributes button on the Editor toolbar.

2. Click next to NAME on the list of attributes, type “AIRPORT DR”, and press Enter.

3. Close the Attributes window.

4. Click the Editor menu and click Stop Editing. Click Yes when prompted to save your edits.

5. Close the Editor toolbar.
6. Right-click arterials_new in the table of contents and click Label Features. The road you added is labeled with its name.

8. Switch to layout view by clicking the View menu and clicking Layout View. You can see that the road has been added to your map.

9. You zoomed in for editing—when you switched to data view—so type “1:100,000” in the Map Scale text box on the Standard toolbar and press Enter to set the map scale.

10. If necessary, use the Pan tool on the Tools toolbar to make your map match what’s shown below.

You can continue with the final exercise or stop here. If you stop, be sure to save your work by clicking Save on the File menu.

7. Turn the cnel65 and airport_area layers back on by checking their boxes in the table of contents.
Exercise 5: Working with map elements

In this exercise, you’ll be applying what you’ve learned, so you may need to refer to previous lessons if you can’t remember how to perform a certain task. You’ll add additional map elements to polish the layout and complete your poster. Then, you’ll print it.

If necessary, start ArcMap, navigate to the folder where you saved the map from Exercise 4 (airport_ex), and open the map.

**Adding a background, titles, legends, and scale bars**

1. Switch to layout view by clicking the View menu and clicking Layout View, if necessary.
2. Click the Land Use data frame on the page so it’s selected. In the table of contents, uncheck the parcels_sel layer so it’s not displayed—that way, the map will show the land use types within the noise contour.
3. Right-click the data frame and click Properties.
4. Click the Frame tab. Click the Background drop-down arrow and click Yellow. Click OK.
5. Click Insert and click Title.

---

**Image:**
- A screenshot showing the background properties dialog box with the background set to Yellow.
- A screenshot of the Title dialog box with the options visible.

---

48 ARCMAP TUTORIAL

4
6. Type “Land Use within Noise Contour” in the text box and press Enter.

7. Click the Text Size drop-down arrow on the Draw toolbar. Click 36 to make the title 36 point.

8. Drag the title onto the Land Use data frame, as shown below.

9. Click Insert and click Legend.

The Legend Wizard appears.

10. Click Next several times to step through the wizard, accepting the default legend parameters. Click Finish when you’re done. Drag the legend to the lower-left corner of the data frame. Make it smaller by clicking the upper-right handle and dragging it down and to the left. You may want to zoom in while you’re working with the legend (use the tools on the Layout toolbar).

Now you are going to make a few changes to your legend to make it more attractive and easier to understand.
11. Right-click the legend and click Properties.
12. Click the Items tab.
13. Click parcels in the Legend Items list, then click the Style button. This will allow you to specify how the Parcels legend entry will be set up.

14. Scroll down and click Horizontal with Heading and Labels. Click OK.

15. Click OK on the Legend Properties dialog box.
You can edit the text of the labels that appear in the legend by changing the text in the table of contents.
16. Rename the LAND_USE heading under parcels to “Land use”. The legend is automatically updated.
17. Use the table of contents to rename the other layers in the Land Use data frame that appear in the legend. Use the list below as a guide for the layer names.

cnel65 Noise contour
airport_area Airport expansion zone

18. Click Insert and click Scale Bar.

19. Click Scale Line 1 and click Properties.

20. Click the Scale and Units tab. Check the box to display one division before zero and change the division units to miles. Click OK on all dialog boxes.

21. Drag the scale bar under the legend, make it smaller, and align it with the legend.

Finishing the layout of the other data frames

Now you will add elements to the other data frames.

1. Click the Population Density data frame to select it. Set the background to Yellow and add a 36-point title of “Population Density”.
2. Rename the items in that data frame in the table of contents. Use the list below as a guide.

- arterials  Arterials
- airport_area  Airport expansion zone
- tracts  People per square mile by Census tract

You won’t use the tracts.POP_DEN heading in your legend, so you can ignore it or simply delete it in the table of contents.

3. Insert a legend using the wizard. Once your legend is on the map, open its properties and click the Legend Items tab.
4. Click People per square mile in the Legend Items list, then click the Style button.

5. Scroll down and click Horizontal Single Symbol Layer Name and Label. Click OK on all dialog boxes.

6. Insert a scale bar. Use Scale Line 1, and show one division before zero and change the division units to miles.
7. Place the legend in the upper-left corner of the data frame and place the scale bar in the lower-left corner. Resize and align the elements to your satisfaction.
8. Go back to the Schools data frame and edit its layout. You may want to resize or reposition the map elements. In addition, you can edit the layer names in the table of contents so the information in the legend is more descriptive.

9. You only need one North arrow since all maps are oriented in the same direction. Click the North arrow in the Schools data frame and enlarge it by dragging the upper-right handle. Then drag the North arrow to the lower-right corner of the page.

You’re now going to add a title for your poster.

10. Deselect the North arrow. Click the Text Size dropdown arrow on the Draw toolbar and click 72 to make the text 72 point size. Make the title bold by clicking the Bold button.

11. Click the New Text tool on the Draw toolbar and click the top of the page. Type “Proposed Airport Expansion” as the title and press Enter. Position the title at the top and center of the page.

**Proposed Airport Expansion**

Adding an extent rectangle

Extent rectangles are a way to show the extent of one data frame within another data frame, such as with an inset or overview map. You need to have at least two data frames in a map to add an extent rectangle, then you will open the Data Frame Properties for the data frame that will be receiving the extent rectangle.

On your layout, you’re going to add an extent rectangle to show the location of the noise contour within the county. This way, your map’s readers will have a better idea about where the proposed airport expansion area is in relation to the county boundary.

1. Insert a new data frame. Resize it to be smaller and position it at the top of the layout, next to the Schools data frame.

2. Rename the new data frame to “County Overview”. Copy the county layer from the Schools data frame and paste it into the County Overview data frame. (You can also drag and drop a layer between data frames to copy it.)

3. Open the Data Frame Properties dialog box and click the Extent Rectangles tab.
4. In the Other data frames list, click Schools, then click the Arrow button. This adds Schools to the Show extent rectangle for these data frames list.

5. Optionally, you can click the Frame button and choose a new border for the extent rectangle.

6. Click OK. The County Overview data frame now has a rectangle defining the proposed airport expansion area.

7. Move and resize the County Overview data frame to a location you like.

Extent rectangles are dynamic in that you can change the extent of either data frame and the extent rectangle will update automatically. Extent rectangles also update when the data is rotated or when the projection is changed.

Adding drop shadows

You can add drop shadows to the elements on the layout page.

1. Click the Population Density data frame to activate it.
2. Right-click the Population Density data frame and click Properties.
3. Click the Frame tab.
4. Click the Drop Shadow drop-down arrow and click Gray 30%.
5. Type “15” for the X Offset and “-15” for the Y Offset.

6. Click OK.
7. Repeat the steps above to add drop shadows to the Schools, Land Use, and County Overview data frames.

Adding a neatline

1. Click Insert and click Neatline.
2. Click Place inside margins.
3. Type in a gap of 36 points. This places the neatline about one-half inch inside the margin of the page.
4. Click the Border drop-down arrow and click a border size of 3.0 points. Optionally, change the background, drop shadows, or other options.

5. Click OK.
6. Optionally, add any other finishing touches to your map.
Printing a map

Your map is finished. You can print it if you have a printer connected to your computer. If your printer doesn’t print the full size (34 by 44 inches), you can scale the map down to fit your printer.

1. Click the File menu and click Print.

2. If the map is larger than the printer paper, click Scale Map to fit Printer Paper. (Tile map to printer paper will print the map at full scale on separate sheets of paper so you can paste them together to display the full map.)

3. Click Setup.

4. Click Portrait for the Paper Orientation.

5. Click OK on the Page and Print Setup dialog box, then click OK on the Print dialog box to print the map.

In this tutorial, you’ve been introduced to many of the ArcMap tasks you’ll often use. The ArcGIS Desktop Help provides more detail on these tasks and shows you many more tasks you can perform using ArcMap.